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Schlumberger Product Documentation

About
Schlumberger

Online
Documentation

Typestyle
Conventions

Schlumberger is the leading oilfield services provider, trusted to deliver superior
results and improved E&P performance for oil and gas companies around the world.
Through our well site operations and in our research and engineering facilities, we
develop products, services, and solutions that optimize customer performance in a
safe and environmentally sound manner.

Documentation is provided in the following electronic formats on the Schlumberger
product CD:

Adobe® Acrobat® PDF files
Online help

You must have Adobe® Reader® installed to read the PDF files. Adobe Reader
installation programs for common operating systems are available for a free
download from the Adobe Web site at www.adobe.com.

The following conventions are observed throughout this guide:

Bold text is used to designate file and folder names, dialog titles, names of
buttons, icons, and menus, and terms that are objects of a user selection.

MBH1 is the left mouse button; MB2 is the middle mouse button; MB3 is the right
mouse button.

/talic text is used for word emphasis, defined terms, and manual titles.

Monospace text (Courier) is used to show literal text as you would enter it, or
as it would appear onscreen.

Throughout the guide, there may be references to other chapters and to other
GeoFrame documents. Some of these references may also be active jump points
(or hyperlinks) indicated by blue text.

A series of boldface, italicized commands separated by greater than sign (>) (for
example, Borehole> Symbols) shows the menu from which the command is
accessed. For example, to choose Borehole> Symbols, move the pointer to the
Borehole menu, hold down MB1 and drag the pointer to the Symbols
command and release.

In GeoFrame documentation, the following procedural words have a precise

meaning:

- Choose means to move the pointer to a command name, or to a menu option
and click MB1.

- Select means to move the pointer to an object in the graphics area of a
window, or to a name (or option) in a pull-down list, and click MB1.

- Enter means to type data via the keyboard and press the Enter key (or click
either OK or Apply).
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Command Bar Most dialog boxes contain a row of buttons near the bottom. Each of these keys has
a standard function that is performed when you click MB1.

» Click OK to close the dialog box and perform the function.

« Click Apply to perform the function without closing the dialog box.

« Click Reset to clear any entries and to return the dialog box to its default state.
» Click Cancel to close the dialog box without changing its state.

» Click Help to display the user documentation.

Standard The standard GeoFrame icons shown in Table 1 are displayed on the left and
GeoFrame I cons right ends of the one-line help at the bottom of each application main window:

Table 1 Standard GeoFrame Icons

lcon Description

Opens the GeoFrame Application
Manager from its icon state.

» When the ITC door is open, the
application can receive updates from other
applications.

» When the I TC door is closed, receiving
events are blocked. An event is an update
or selected data item.

The I TC broadcast icon sends events to one
-"':') or more open applications.

Opens the I TC Filter dialog box to select
? which events to send and which events to
receive. The selections will vary from one
application to another.

Information Resources 7

Copyright © 2010-2013 Schlumberger. All rights reserved.



Alert Statements The alerting statements are Notes, Cautions, and Warnings. These statements are
formatted in the following style:

Note: Information that is incidental to the main text flow, or to an important
point or tip provided in addition to the previous statement or instruction.

Caution: Advises of machine or data error that could occur should the user fail
to take or avoid a specified action.

Warning: Requires immediate action by the user to prevent actual loss of data
or where an action is irreversible, or when physical damage to the
machine or devices is possible.
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Contacting Schlumberger

Technical Support  Schlumberger has sales and support offices around the world. For Technical Support
for SIS software, go to support.sib.com.

Information Resources 9
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2 GeoFrame Data Connector
| ntroduction

I n This Section

[ 1772 V7= 11
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Overview

The GeoFrame Data Connector plug-in for Petrel facilitates the direct exchange
of data between GeoFrame and Petrel. Easy-to-use interfaces and map-based GIS
selection provide rapid and reliable movement of data.

The following data can be exported from GeoFrame as seismic and .zip files using
Basemap for import into Petrel:

» 3D stacked | ESX and Charisma seismic data exported in ZGY format (available
on Linux only)

» 2D stacked | ESX and Charisma seismic data exported in SEGY format
« 2D and 3D seismic interpretation (horizons and faults) as interpretation models
+ Fault boundaries

» Well data (boreholes, deviation surveys, checkshots, logs, lithofacies, and
markers)

The following data can be exported from Petrel as .zip files and imported into
GeoFrame using Basemap:

» 3D seismic interpretation (horizons and faults) into new interpretation models
* Well data (boreholes, deviation surveys, markers, and log curves)

This document is divided into five sections:

» Exporting data from GeoFrame

* Importing GeoFrame data into Petrel

» Exporting data from Petrel

» Importing Petrel data into GeoFrame

 Installation of the GeoFrame Data Connector plug-in

A table listing the data types that can be exported from GeoFrame to Petrel and
their related versions can be viewed in Appendix A GeoFrame to Petrel on page
68.

A table listing the data types from Petrel to GeoFrame and their related versions
can be viewed in Appendix B Petrel to GeoFrame on page 74.

Note: Agf data manager license is required to launch the GeoFrame exporter/
importer in Basemap. An OCEAN_SLB_GF DATA CONNECTOR license is
required to launch the GeoFrame data connector in Petrel.

GeoFrame Data Connector Introduction 77
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3 Export to Petrel

In This Section
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Overview

2D and 3D seismic interpretation, 2D and 3D stacked seismic data, and well data
can be exported from Basemap for use in Petrel. These data can be exported using
user drawn polygons, saved rectangular and polygonal | ESX Areal paths, GIS data,
and GeoViz RAM volume definitions. Multiple output files can be sent to a
user-selected directory.

Note: Agf data manager license is required to launch and run Export to
Petrel.

Export to Petrel 13
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GeoFrame to Petrel Workflow

Petrel > Export to
Petrel

The following is a simple workflow for exporting seismic, interpretation models, and
well data to ZGY and Zip files. The assumption has been made here that the
GeoFrame Data Connector plug-ins have already been installed (see Chapter 7:
I nstallation on page 64). Details on all options are listed below the workflow.

» To Export 2D and 3D Stacked Seismic, I nterpretation Models, and Well

Data to SEGY, ZGY, and Zip Files
Open Basemap and select Petrel > Export to Petrel.
The Export Data for Petrel Project dialog box opens.
Select your areal extent using either: the Graphic Mode or List Mode.

a. If using Graphic Mode, you can select by manually drawing a polygon or
selecting from posted GIS polygons.

b. List Mode gives you several options for selecting existing polygons. Make
your selection.

Make Seismic, Interpretation Model, and/or Well Data selections.
a. If making seismic selections, do the following:

» Click the Seismic Tab, select the domain, the 3D survey(s) and/or 2D lines,
then class, and review and change any parameter selections.

+ Click MB1 on the Output Seismic Volume button to put the selections in
the Output Selections (cont) list.

* Repeat for as many survey/class pairs as needed.

« Click the Interpretation Tab, select the survey(s) and/or 2D lines, review
and change any parameter selections, then click MB1 on Output Horizons
and Faults.

* Repeat for as many surveys and 2D lines as needed if multiple surveys
and/or 2D lines were not selected.

b. All fault boundaries that are contained in or intersect the selected output
polygon can be selected for export by clicking Output Fault Boundaries.

c. If making well data selections, do the following:

» Click the Well Data Tab, select the log curves, lithofacies data, and markers
to transfer.

« Click MB1 on Output Well Data.

Note: Well Data tab will be dimmed if no boreholes are posted on the map.

4

5

Review your selections in the Output Selections section, and adjust the list as
needed using the Scissors (M) icon.

Go to the Petrel Output Controls section and select the output directory
where you want to export the ZGY and Zip files.
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10

11

Make any output Projection or Unit changes at this time. Verify CRS settings
set as needed.

Click OK or Apply.

The export begins with a progress report opening. When the progress report is
no longer on the screen, the export is complete.

Go to a Windows PC and open Petrel to start loading the ZGY file.

Load your 3D interpretation by locating the  mport from GeoFrame folder in
the Processes section on Petrel’s data tree.

Open the folder and select | mport an interpretation model which opens
the Import an interpretation model dialog box and load your model(s) and
fault boundaries here.

With the folder still open, select I mport well information which opens the
Import well information dialog box and load your well data here.

Now, select Import 2D seismic and interpretation option to open the
Import 2D seismic and interpretation dialog box where you can load your
2D seismic and interpretation.

[ O Export Data to Petrel =

®
[©)
%)

Polygon Selection

< Graphic # List Selector Type  Basemap Selection Polygons 1 | Save Folygon Selector . | | Zoom to Polygon l(j 'Zi

Type Description
GIS_polygon GIS_FEATURES test polygon for GIS

poly 1 USER_DRAWH _test

poly 2 USER_DRAWH  test polygon

L
GeoFrame Data Type
Seismic | Interpretation | Well Data ]
Domain | Time = | Minimum *[ Masitoumn 2] w sko [0 ( )Format| Default o |Cnvemge Inside Polygon 1 |
ZGY datarange .- From source 4 From source symimetrical W Zero centric
= i ml ] el (=) = (e
Seismic Lines/Surveys i| ﬂ Available Classes 4 ___! M L] = 7‘.!
il Pos | Hame | Description
1] 0 | velzd_2700 | velzd_2700
2700 ies |/
| S — = 6|
Output Seismic Volume I Load dass Priority 351 i Class handling = Selections =1
!
Qutput Selections ﬂ il
ES7T Domain Name Est. Max Size Details B
Seismic Time 2700 _iesx_2702_timemiy_seismic_time.seqy 476.0 k 2702 (polygon); timemig_seismic [6 -» IBM] Rev_1:ASCIl & None; 0.0 : 4000.0 ms
Seismic Time 2700 _jesx_2703 timemig_seismic_time.segy 778.5 k 2703 (polygon); timemig_seismic [5 -> IBM] Rev_1:ASCIl & Hone; 0.0 : 4000.0 ms
|-f
¥

Petrel Output Controls

Projection I NADZ7 Louisiana State Planes, Southem Zc Set Projection .. X¥Units| ft o

CRS: |SF‘CSZ7J 702 4 Use CRS - Use WGS54 | Zip 2D interpretation files é}!aa)rainicarihjaa.zip

Qutput Directory E ismi 2_Inx Select...
M Run in Background I Use date-time for suffix |

oK Spply Reset Cancel | Help |

| Select and define seismic output.

Fig. 1 Export Data for Petrel Project dialog box
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Export Data for Petrel Project

The following describes the parameters and their usage rules for exporting 2D and
3D stacked seismic data, interpretation models, fault boundaries, and well data
using the Export Data to Petrel dialog box. The Export Data to Petrel dialog
box contains the following sections and Command Bar:

Option Description

Polygon Selection Select the areal extents (XYs) of the export
area. Data for export can be selected in two
ways:

+ Graphic Mode - Draw a polygon over the
area that you want to export data from on
the basemap or graphically select GIS
polygons to use as the limits.

» List Mode - Use existing | ESX Areal Paths
(rectangular or polygonal), saved
Basemap selection polygons, GeoViz
RAM Volume Definitions, or Data
Boundaries.

GeoFrame Data Type Select stacked seismic, interpretation, and
well data to export using Seismic Tab,
I nterpretation Tab, and Well Data Tab.

Output Selections Multiple seismic and interpretation selections
can be made and will list with information
such as Type (I nterpretation or Seismic),
Domain, Name, and any related Details. A
Clear button is available to completely empty
the list or items can be selectively removed
from the list by clicking MB1 on the item and

then clicking the Scissors( M) icon.

Tip: Parameter changes can be made to
selections in the Output Selections list
without having to remove them from the list.
7o make changes, click MBT to highlight the
item in the list you want to change. Edit the
parameters, such as Z range or Coverage,
in the GeoFrame Data Type section and
then click MB1 on Output Seismic
Volume.
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Graphic Mode

Option Description

Output Selections Note: Only one Polygon Selection can be
(cont) made per export run. If you try to select
another polygon after the Output
Selections section has been populated, you
will receive a confirmation message stating
that this list will be cleared if another polygon
selection is made.

Petrel Output Controls Defines how the data selections listed in the
Output Selections area will be exported to
the Zip file.

GI'S polygons can also be used to select the XY area for output. With the GIS data
displayed and while in Graphic mode (use MB3 > Select (Point) Mode), click
MB1 on the GIS polygons to define the areal extent. The selected polygons will
have a yellow outline until MB3 > Break is clicked. Then the outline turns red
indicating these are the selections that will be used as the XY extents for export. At
any time, if you want to reselect your polygons, click MB3 > Clear to start the
selection process over again.

Note: To make polygon selection easier, turn polygon fill ON (a transparency
factor can also be used) to allow you to pick anywhere on the polygon.

» To Graphically Make a Selection Polygon
1  Toggle ON the Graphic radio button (use MB3 > Draw (Poly) Mode).
2 (Click MB1 to draw (MB2 to remove points) the polygon.

Once complete, click MB3 on the canvas and select Break.

The MB3 options are:

Option Description

Break Completes the polygon. Use this when you
have finished drawing your polygon.

Clear Removes all the points you have picked, to
restart the polygon draw.

Draw (Poly) Always ON, constantly in drawing mode.

Save Opens the Save Polygon Selector dialog
box and allows you to save the polygon for
later use.

Export to Petrel 17
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Save Polygon Selector The Save Polygon Selector dialog box contains the following options and
Command Bar:

Option Description

Name Enter the name of the polygon you want to
save.

Remark Enter additional information about the
polygon you want to save.

List Mode

P 7o Use Saved Rectangles and Polygons in the Selection Area
1  Toggle ON the List radio button.

2  Select one of the following from the Selector Type option list:

Option Description

Basemap Selection Polygons Lists the polygons saved using the Graphic
polygon drawing method.

| ESX Areal Paths Lists all the rectangular and polygonal paths
in the project.

Posted | ESX Areal Paths Only posted rectangular and polygonal paths
are displayed.

GeoViz RAM Volume Use the XY extents of any saved GeoViz RAM

Definitions volumes. The volume definitions only display
for the 3D surveys that are posted on the
Basemap.

Note: GeoViz RAM volume definitions are
available for | ESX definitions only and are
not implemented for Charisma.

Note: Any trace decimation done when
creating the RAM volume is ignored and only
the XY extents are honored.

Data Boundaries Lists any Inclusive Data boundaries in the
project.

Note: |ESKX areal paths can also be used to limit the extent of Charisma
surveys.

Note: Zranges contained in the rectangular and polygonal paths are not
considered or used during the export process.
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Polygon Selection The Polygon Selection section also contains the following elements:

Option Description

Opens the Save Polygon Selector dialog
box where a name and optional remarks are
entered to save your graphic polygon
selection.

Save Polygon Selector

Note: This option is only highlighted when
you are in the Graphic select mode and a

polygon has been created or GIS selections
have been made.

Show Extent When toggled ON, Show Extent will cause
Basemap to unzoom to the extents of the
Polygon Selection.

XI Deletes Basemap Selection Polygons.
Seismic Tab The Seismic tab contains the following elements:

Option Description

Domain Select Time or Depth.

Minimum and Maximum Z Select the Z range to export after the input

class has been selected. Default is the full Z
range of the class. Available only when a
single 3D survey/class or 2D line/class
selection is made.

Z Units Ability to export depth data using feet (ft) or
meters (m) for Z-units only available when
Domain is set to Depth. Time is always
exported in milliseconds (ms).

SRD Turn ON to apply project’s Seismic
Reference Datum (SRD) to ZGY exported
seismic. Available only for Charisma seismic.

By default, the project’s SRD is automatically
populated in the text entry box located next
to the SRD toggle, but can be changed to
another user-defined value.

Note: Active when Domain is toggled to
Depth.

Format Select the output format 8, 16, or 32-bit for
the 3D ZGY and 2D SEQY files. Default
selection is the current format of the class.

Export to Petrel 19
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Option Description

Coverage Select the containment method for seismic
trace output. The options are:

« Entire Survey/ Line - Overrides any
polygon selections and exports data for the
entire survey and/or 2D line.

+ Bounding Box - Builds a rectangular box
parallel to the 3D survey orientation from
the selected polygon and populates the
entire rectangle with live traces (if live
traces are available).

« Inside Polygon (Default) - Exports data
within the polygon selection.

Note: When exporting using a polygonal
path, dead traces will be used to fill in the
gaps when creating the rectangular (Petre/
requires surveys to be rectangular)
dimensions needed for the output 3D
survey. The bounding box is built parallel to
the 3D survey orientation.

ZGY data range Allows you to select the method for ZGY
export.

+ From source - The output ZGY file will
contain the input source data range exactly
as it is stored in the GeoFrame database.

+ From source symmetrical - The output
Z@GY file will contain the input source data
range symmetrical to the highest absolute
value.

« Zero centric - If you are exporting to an 8
bit or 16 bit resolution ZGY file, toggle this
option ON to adjust the target data range
so that the original data zero value is
preserved.

Seismic Lines/ Surveys Lists the 3D surveys and 2D lines available for
selection. 2D and 3D surveys posted on the
basemap and selected by the polygon are
listed and available for selection.

Available Classes Lists the available classes (versions) available
for export. This list is dependent on the
survey selection.

GeoFrame 2012_SP_3: GeoFrame Data Connector online help
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Option Description

Class handling + Selections - Attempts to export a 3D
survey and/or 2D line (if highlighted in
Seismic Lines/ Surveys list) for each
class selected in the Available Classes
list.

» Class Order - Will export only one class of
data for each 3D survey and/or 2D line
selected in the Seismic Lines/ Surveys
list. The order of output is based upon the
class order in the Available Classes list,
with output being from top to bottom. That
is, for each highlighted 3D survey or 2D
line, the Available Classes list is
searched from top to bottom and the first
class it finds for the 3D survey or 2D line
will be put in the Output Selections list.
To change the order that classes are
exported, select a class(es) and use the
four (4) icons to reorder them.

° & - Moves the selected class down
in the list.

« |X " - Moves the selected class up in
the list.

+ &7 - Moves the selected class to the
bottom of the list.

* %" - Moves the selected class to the
top of the list.

Load Class Priority List Loads the Class Priority settings made in
Seis% DV. Selecting this will reorder the
classes in the Available Classes list. The
Class Priority list can be set in Seis% DV
Define > Class priority.

Output Seismic Volume Click this button to put the survey/class pair
and its parameters in the Output Selections
area.

Tip: If parameters exist in the Output
Selections area and a change is needed on
an item, highlight the item change the
parameter(s) and click Output Seismic
Volume.

GeoFrame “conditions” the seismic data prior to export to ensure it will load into
Petrel. The following is useful information pertaining to 2D seismic export/import:

Export to Petrel 21
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Interpretation Tab

22

Traces at the beginning or end of 2D lines that do not contain navigation are
not exported. In cases where there is no navigation in the middle of a 2D line,
it will be interpolated, and the traces exported.

2D lines imported into Petrel will be named by the GeoFrame survey name
and class separated by two colons - survey::class.

If a selected 2D line falls outside the polygon in the middle of the line, live
traces will be exported for the portion of the line that falls within the polygon.
Dead traces with navigation are exported for the portion of the line that are
outside the polygon.

The Petrel importer (Input data dialog box) is used to load the data so be
sure to select the correct loading template.

2D seismic is exported using SEGY Revision 1 with no extended headers. This
format is used so line information can be written in ASCII in the textual header
for later review and identification purposes.

In some unusual cases, for example huge changes in navigation but no trace or
CDP increments changes, Petrel may load a 2D line in parts and put them in a
2D line folder. Lines of this nature will be identified in the Status column of the
Results of import section of the Import 2D seismic and interpretation
data dialog box, where you are asked to review them.

If there are duplicate trace numbers in a 2D line in GeoFrame, only the first
duplicate trace will be imported into Petrel and the others ignored.

If there is duplicate navigation for adjacent traces, the traces with duplicate
navigation are not exported. The exporter uses the rule that if adjacent Xand Y
locations are less than or equal to one, they are considered duplicates and will
not be exported. Sometimes due to rounding errors, the exporter may export
these traces and Petrel will consider them as duplicate traces.

It is a good practice to run a full scan on the 2D lines after they have been
loaded in Petrel.

The I nterpretation tab contains the following elements:

Option Description

Domain Select Time or Depth.

Coverage Select the containment method for seismic

trace output.

Output Fault Boundaries Click this button to export all the fault

boundaries that fall within or intersect your
selected polygon.

Output Horizons and Faults Once the selections are made, click this

button to put in the Output Selections
section.

Tip: A Select All icon is available for multiple
survey selection.

GeoFrame 2012_SP_3: GeoFrame Data Connector online help

Copyright © 2010-2013 Schlumberger. All rights reserved.



Note: Model export is limited to the current Time or Depth model. To select a
different model you must exit all | ESX applications, and reselect the
models from the | ESX Session Manager. /f you are running standalone
Basemap, you must exit and restart Basemap and reselect the models
from the Model Selector dialog box.

Well Data Tab The Well Data tab contains the following elements:

Option Description

Transfer Logs Choose one of the following from the
Transfer Logs option list:

« LCPS - Allows you to select an existing
Log Curve Preference System (LCPS)
to choose the logs to send to Petrel.
Selecting this option activates the Select
button which opens the Select LCPS
dialog box where you can select an existing
LCPS.

» User Logs - Selecting this option activates
the User Logs button, which opens the
Log Codes dialog box where you can
select the log curves to transfer by code
type.

» All Logs - All the logs for the selected
boreholes will be transferred. That is, the
preferred logs code is transferred if it is set.
If the preferred logs code is not set, then
the latest time stamped version of a log
code is transferred. Multiple logs of the
same log code are not transferred.

* None - No logs are transferred.

Transfer Lithofacies Choose one of the following from the
Transfer Lithofacies option list:

« Lithology Versions - Allows you to send
one or more Lithology versions to Petrel.
Selecting this option activates Select
which opens the Lithology Version
Selection dialog box, where you can
select one or more lithology versions.

» None - No lithofacies data is transferred.

- All Versions - All the lithofacies data for
the selected boreholes is transferred.
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Option Description

Transfer Markers Choose the markers to send to Petrel by
selecting one of the options from the
Transfer Markers option list:

« Surface Set - Allows you to transfer a
collection of markers for the selected
boreholes to Petrel. This can be an existing
set or can be created within this option
using the create Surface Set icon.

« All Surfaces - All the markers for the
selected boreholes will be transferred.

» None - No markers are transferred.

Output Well Data button Click this button to put your well selections
into the Output Selections section for
export. The Output Name text box is for
informational purposes only and reports the
name that will be given to the output zip file
name.

Note: The Well tab will only be highlighted if boreholes are posted on the map.

Note: For a borehole to be included in a transfer file its well top must be included
within the selection polygon.
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Transfer Rules /
General

Information Option Description

Boreholes The Working Datum (WD) is transferred from
GeoFrame to the Kelly Bushing (KB) of
Petrel. Well Symbols are mapped between
GeoFrame and Petrel and are consistent
with the way OpenSpirit maps them. The
preferred deviation survey is transferred to
Petrel using True Vertical Depth (TVD). The
preferred checkshot survey is transferred
using TVD, if TVD is not found, the Measured
Depth (MD) is used. If the preferred
checkshot for a borehole you are transferring
belongs to (referenced from) another
borehole it will not be transferred and it is
your responsibility to load it in Petrel. A
workaround for this problem would be to
include the borehole that owns the checkshot
in the export, and then once the Zip file is
imported into Petrel, open the Settings >
Time tab of the borehole you want the
checkshot assigned to and assign it manually
by using the shared checkshot option.

Logs GeoFrame log codes are mapped to Petrel
well log templates. There are many more log
codes in GeoFrame than Petrel well log
templates. Therefore, some GeoFrame log
codes may be mapped to a different well log
template in Petrel. The original GeoFrame
log code is placed in the Log’s comments for
your review. Also, you will see a list of log
codes in the Petrel Message window, if the
log codes in Petrel are different from
GeoFrame.

Export to Petrel 25

Copyright © 2010-2013 Schlumberger. All rights reserved.



Option Description

Logs (cont) A workaround is to check the global log
template, rename or create a new global log
template, and reassign to each log code (can
compare with comment of each log). Discrete
logs (Facies logs, etc.) and time logs are
currently not exported. When the Preview
option is selected, the Available Log Curve
Tool (ALCT) is displayed to show your
current selections. Some of the log export
rules and information are explained below
when a project LCPS is set:

+ The LCPS selected in the Export
Borehole Data to Zip dialog box
supersedes the project LCPS.

« The project LCPS is not used if you use the
User Logs option. The preferred log code
will be used rather than the LCPS settings.

+ If the project LCPS is set and User Logs
is selected with no preferred logs set, the
latest time stamped log will be exported.

* |t is recommended that you preview your
log export selections any time a LCPS is
used, since a LCPS is project based and
can be changed by another user without
you realizing it.

Lithofacies Lithofacies are transferred using MD values.

Facies names are transferred, however not all
colors or patterns are transferred. If the
colors are standard GeoFrame colors
without a number extension, they transfer
properly. If they have a numeric extension,
for example MistyRose3, they will transfer
in Black. A workaround is to assign the
closest color that does not have a numeric
extension.

GeoFrame has 64 basic predefined patterns
along with user-defined patterns. Petrel has
34 basic predefined patterns. A mapping of
the patterns is defined by default between
GeoFrame and Petrel. To manually change
the colors and patterns, you can edit the

gf path map.txt file.
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Option Description

Markers

Markers are transferred using MD values. If
there are no MD values the marker is not
transferred. If a marker to be transferred is
indexed in something other than MD (for
example, TVD) the marker value transferred
will still be the MD value. If the Marker
Preference System (MPS) is active,
markers will also be filtered based on those
settings. Marker colors are not transferred
and are assigned according to Petrel
standards. Markers must be associated to a
surface before transfer.

Output Selections

The seismic, interpretation, and well data
selections are listed here. The types of data,
domain, name, estimated size, and details of
the data are listed here.

. /I - Removes all selections from the list.

* Move i” - Removes the highlighted
selection from the list.

Petrel Output Controls The Petrel Output Controls section contains the following elements:

Option Description

Projection

By default, shows the Projection system used to
create the map will be used for the export.

Set Projection

Select another projection to use for exporting.

XY Units

Allows you to change the XY units of the data you are
exporting. You can select:

em
o ft
« ftus
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Option Description

CRS CRS is the Coordinate Reference System code that is
used to match the coordinate system output by
GeoFrame with the coordinate system of Petrel. The
CRS code listed in GeoFrame can be seen in Petrel’s
Coordinate reference system selection dialog
box.

When a Zip file is imported into Petrel, if there is a
match between the coordinate system in the Zip file
and a coordinate system available in Petrel, the XY
data will be converted from the Zip file coordinate
system to the Petrel project’s coordinate system.
Currently, the following data items are imported to
Petrel using XY values using the GeoFrame data
connector:

» Fault boundaries
» Well surface locations
» Well deviation survey XY values

If no coordinate system match is found between the
Zip file and Petrel, an information message is
displayed with a choice of continuing or cancelling the
import. If the choice to continue is made, no
coordinate conversion is done and the data’s XY
values are loaded as is, only unit conversion is
performed.

GeoFrame can have user-defined coordinate
systems beyond those that are pre-defined. These
coordinate systems do not have a CRS name that can
be matched with Petrel. To handle cases like this, the
Use WGS84 option can be used. This will export the
data as latitude/longitude in a neutral coordinate
system and allow Petrel to perform the coordinate
system conversion to the project’s coordinate system.

Note: 3D stacked seismic cannot be exported using
the Use WGS84 option. It will be exported using the
currently selected CRS.

Zip 2D interpretation Toggle ON to put all the 2D interpretation files into a
Files single Zip file.
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Option Description

Output Directory

Specify the directory where the files will be output.
The directory must already exist and you must be
able to write to it. A sub-directory (1 level) will be
created for you if you type in a sub-directory name
that does not exist.The following output file naming
convention is used:

+ Seismic -
<survey name> <class name> <domains>.z
gy

+ Interpretation -
<interpretation model name> <survey n
ame> <domains>.zip

+ Fault boundaries -
<interpretation model name> Fault Bou
ndaries <domains>.zip

+ Well data - BOREHOLES LIST <Log
curves> <markerss>.zip

+ GF_PETREL_OUT_DIR - Set this environment
variable and the output files by default are located
in the specified directory. Set the command by:

setenv GF_PETREL OUT DIR

directory path or use BasemapEnvVars.txt and
enter the line:

GF_PETREL OUT DIR directory path

Select Opens the Select directory for data output dialog
box to make the directory selection or manually enter
it in the text entry box next to the Select button.

Run Select an option from the option list.

- Background - ON by default, this option allows
the export to take place in the background, which
means you can execute other tasks with less
performance impact.

Note: Graphically drawn polygons must be saved in
order to use this option.

« Immediate - Runs the export in Foreground on
the current map as soon as OK or Apply is clicked.

« Write File Only - Allows you to write an XML file
(outSummary.xml) that lists the items to export
that can be used later by a command line tool to
import the data into Studio.

Use date-time for suffix

With this button ON, a date-time stamp is
automatically added to the output files. If this button
is turned OFF, a suffix can be manually entered in the
text entry area next to the button. You cannot have
both a date-time and manually entered suffix.
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Progress Report /
Log File

Once you are satisfied with your selections, click OK or Apply. The export begins,
and a progress dialog box opens which reports information on the polygon used for
export. The dialog box shows on the survey/class being exported (output file name,
Line/CDP/Z range, Projection, Datum, Ellipsoid, Units, and export percentage
complete) and interpretation model export information.

Alog file (bmap petrel run.log) is also created in the directory where the ZGY
and Zip files are exported. This contains the export information from the progress
report along with information about the interpretation export. Also, a log file
(omap_petrel batch.inf) is created in the directory where well data is
exported when not all well data is exported and when well data is exported with
saved polygon. When well data is exported with an unsaved polygon, the same log
file appears in the Process Messages dialog box instead of a log file. If a date-time
suffix is used in the export that will be appended to the log file name.
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Export Framework 3D to Petrel

The Export Framework to Petrel option allows you to export a Time or Depth
framework model to a zip file. This zip file can be loaded into Petrel using a
GeoFrame Data Connector plug-in for Petrel.

With the exception of Fault I ntersections, Original Horizons Grids, Truncated
Fault Grids, and Fault Polygon Sets, which are always exported, you have
control over exporting all the other Framework 3D data such as Original Fault
Grids, Fault Tip Loops, etc.

» To Export A Structural Framework

1

7

Open Framework3D from the Seismic Catalog (or Visualization
Catalog).

Select File > Export Framework to Petrel.
The Export Framework to Petrel dialog box opens.

Click on the structural model to export from the Select Structural
Framework to Export list.

Review the Framework Data for Petrel Model (always exported) list.

Click on the buttons of any additional data to export in the Additional
Framework Data to Export section.

Use the Select All icon if you want to export all the data.

Click Select File to open the standard Select Output File dialog box where
you can output the Zip file to the directory of your choice.

If no selection is made, a default file name, consisting of the model name and
survey, will be output to your default directory (/project directory/CPS).

Important: You can use the Output File text entry box to type in an output file
name If you want to export the Zip file to your default directory (/
project directory/CPS) and bypass the Select File button.

Click OK to export the file.

Note: Framework 3D models are exported using the grid library’s Local

Coordinate System (LCS). No coordinate conversion is done when the
model is imported into Petrel.
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Export Framework to
Petrel

options and a Command Bar:

The Export Framework to Petrel dialog box (see Fig. 2) contains the following

Option Description

Select Structural Framework
to Export

A list of structural frameworks in the project
available for export. Use Find to locate a
structural framework if the list is long. You
can get detailed information on the
structural framework by clicking the

Information (ﬂ) icon.

Framework Data for Petrel
Model

A read-only list of framework data that are
always exported.

Additional Framework Data to
Export

Select any additional framework data you
want to export.

Output File

You can enter the output filename in this
text field, or select a directory and enter an
output filename by clicking Select File to
open the Select Output File dialog box.

xport Framework to Petrel

Select Structural Framework to Export{1Z displayed) ___ﬂ;l
Domain Source Owner Remarks I Ay
aaa Depth  Framework 3D install
ada Time  Framework 3D install
hbh Depth  Framework 3D install
hbh Time  Framework 3D install =
faull test Depth Framework 3D install
fault_test Time  Framework 3D install
Wcz Depth  Framework 3D install

|

Selection |fa.ult_test STRUCTURAL_FRAMEWORK .Depth [C50636]

Framevrork Data for Petrel Model {always exported)

Fault Fault Intersections  Onginal Horizon Grids

Truncated Fault Grids

W Onginal Fault Grids

M Fault Tip Loops

Fault Folygon Sets

Additinnal Framewnrk Data in Fxnort.

i

1 Blanked Traces

| Blanked Horzon Horizon Intersections

|§ Extrapolated Fault Grids

| Limited Grd

| Fault Traces

1 Fault Centetines

| Blanked Grid

1 Limited Traces

_1 Limited Horizon Honzon Intersections

i Fault Truncation Rules

oK |

Output File [fault_test Depth.zip

Select File... |

Cancel | Help |

]

Fig. 2 Export Framework to Petrel dialog box
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Overview

2D and 3D stacked seismic data, 2D and 3D seismic interpretation and well data
exported from GeoFrame can be imported into Petrel. 2D stacked seismic data is
exported as SEGY, 3D stacked seismic data as ZGY, 2D and 3D seismic interpretation
and well data as Zip files.

These exported data can be imported into Petrel using the GeoFrame data
connector plug-in and in the case of the 3D stacked seismic ZGY files, the standard
Petrel loader.
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Reading a ZGY File I nto Petrel

ZGY formatted 3D stacked seismic files can be exported from GeoFrame (Linux
only) using Basemap or ZGY Utility. These files can then be read into Petrel.

1

» To Read the ZGY Data into Petrel

Open Petrel, click MB3 on the data tree and select Import (on tree).
The I mport file dialog box opens.

In the Import file dialog box, toggle Look in to the directory your ZGY file is
in.

Toggle the Files of type option to Seismic data in ZGY bricked format
(*.zgy).
Select the ZGY file from the list and click Open.

The Import data dialog box opens where you can enter a new vintage (class/
version) of data or use the default vintage, verify settings, confirm correct
Coordinate reference system is selected, confirm unit conversions are correct,
and click OK.

The data is now available to be displayed in Petrel.
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Petrel Plug-in Usage

Once the plug-in is installed, you can locate it in Petrel by looking for I mport from
GeoFrame in the Processes list. Once you have located this entry, open the folder
and you will see the following options:

Export 3D seismic interpretation

Import 3D interpretation and Fault Boundaries (2D and 3D)
Export well information

Import well information

Import a Framework 3D model

Import 2D seismic and interpretation data

Import 3D
interpretation and
Fault Boundaries
(2D and 3D)

To Import an I nterpretation Mode/
Select Import 3D interpretation and Fault Boundaries (2D and 3D).

The Import 3D interpretation and Fault Boundaries (2D and 3D) dialog
box opens (see Fig. 3 on page 37).

Select the survey in Petrel to load the interpretation model into and click the
blue arrow.

The survey field is populated.

Note: When loading fault boundaries, a survey selection is not required.

Use the Browse option to select the interpretation model Zip file to import.

(Optional) Supply a Name prefix/ suffix by clicking the button and supplying
a name.

Click OK.
The interpretation model now loads into the selected survey.

When the interpretation model loads, the horizons and fault sticks appear in
the Petrel Input pane as a sub folder under the Seismic folder called
“GeoFrame: Interpretation Model_Survey_Name”. The fault boundaries appear
as a separate folder in the Petrel Input pane named “GeoFrame fault
boundaries: Interpretation Model_Survey Name”.

When the Import 3D interpretation and Fault Boundaries (2D and 3D)
option is selected, the Import 3D interpretation Fault Boundaries (2D and
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3D) dialog box opens with the following | mport model tab option and Command

Bar:
Option Description
Seismic survey Select the name of a survey and click the blue

arrow.

I nterpretation model to import | Use Browse to locate an interpretation
model Zip file to import.

Name prefix (optional) Toggle this option ON and enter a name in
the Name prefix field.

Name suffix (optional) Toggle this option ON and enter a name in
the Name suffix field.

There is also an I nfo tab which provides instructions on how to use this import tool.

@ Import 3D interpretation and Fault Boundaries{2D and 3D) [&J

Import model ;"||-|fo |

Seismic survey: |§| Westcam

Interpretation model to import: E)efauh_nwc_‘l_'l’ime.zip Browse...
"] Name prefix:

[¥] Name suffoc: test

vy |[ wvok || cancel |

Fig. 3 Import 3D interpretation and Fault Boundaries (2D and 3D) dialog
box

Import well
information
» To/mport Well Information
1  Select Import well information.
The Import well information dialog box opens (see Fig. 4 on page 38).
Use the Browse option to select the well Zip file to import.
3 (Optional) Supply a Name prefix/ suffix by clicking the button and supplying
a name.
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4  Click OK.
The well data now loads.

When the Import well information option is selected, the Import Well
I nformation dialog box (see Fig. 4) opens with the following I mport wells tab
option and Command Bar:

Option Description

Well file to import Use Browse to locate a well Zip file to
import.
Name prefix (optional) Toggle this option ON and enter a name in

the Name prefix field.

Name suffix (optional) Toggle this option ON and enter a name in
the Name suffix field.

There is also an I nfo tab which provides instructions on how to use this import tool.

S Impart well information [
Impon wels | i |
Well file to mpont Browse,
Name prefoc
HName sufipg
[« dooy | [ <0k "r.‘cmet|‘
|

Fig. 4 Import Well I nformation dialog box

Import a The Import a Framework 3D model dialog box (see Fig. 5) opens with the
Framework 3D following I mport model tab option and Command Bar:
model

Framework to import Use Brow se to locate a framework model Zip

file to import.

Name prefix (optional) Toggle this option ON and enter a name in
the Name prefix field.

Name suffix (optional) Toggle this option ON and enter a name in
the Name suffix field.

There is also an I nfo tab which provides instructions on how to use this import tool.
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Import 2D seismic
and interpretation
data

& Import a Framework 3D model @

[mport model | kg

Framewark to import: A boundary\C_1_Time.zip
[ ] Mame prefis:

[ ] Mame suffis;

ey || vk ][ X Caneel |

Fig. 5 Import a Framework 3D model dialog box

2D seismic and interpretation exported from Basemap using the Petrel > Export
to Petrel tool can be imported into Petrel using the Import 2D seismic and
interpretation data option found in the GeoFrame data connector folder in the
Processes pane. When this option is selected, the I mport 2D seismic and
interpretation data dialog box (see Fig. 6 on page 41) opens with the
information on the Seismic tab presented.

Important: Only 2D seismic and interpretation files exported from Basemap >
Petrel > Export to Petrel should be loaded using this dialog box.
Any files that were created outside of Basemap > Petrel >
Export to Petrel may not be properly conditioned and you may
have trouble associating the interpretation to the 2D lines due to
naming conventions used when the export/import process is done.

The Seismic tab includes the following parameters and results section:

Option Description

2D survey Survey to contain the 2D lines to be loaded.
Select an existing survey from the Petrel
Input pane and click the blue arrow icon.

New 2D survey name Rather than performing the option above, you
can enter a new survey name in the adjacent
text box. The name entered here overrides
the selection in the 2D survey option.
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Option Description

Associate Performs the data selection and initiates the
load. Click Associate to open the | mport
file dialog box to make SEG-Y file selections.
If a coordinate system has already been
selected for the project, the 2D seismic will
begin to load as soon as OK is selected. If no
coordinate system has been selected for the
Petrel project, a prompt will appear asking
you to select a coordinate system or to select
null. If null is selected, the coordinates for the
2D seismic will be identical to those used
when exporting from GeoFrame.

As the load starts, you are presented with the
standard Petrel Input data dialog box with
information and options pertaining to the first
line you are about to load. Review this, make
any changes (none are required), and click
OK to review the next line or OK for all to
have the load continue without stopping for
the rest of the lines.

Result of import Sortable spreadsheet that reports the lines
loaded, the location of the SEG-Y file of the
2D line, and the loading status.

Note: If you are only loading 2D seismic into
the Petrel project, you can MB3 click on the
2D survey in the I nput pane and select
Import 2D Seismic from GeoFrame. This
will open the Import file browser to select
the 2D lines and then the Petrel importer
(Input data dialog box) is used to load the
data.
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& Import 2D seismic and interpretation data

H -n.t.erple-t.atinn Infa

20 survey: . 2D ?HWFH

Mew 20 survey name: BN Survey

Select files, designate input CRS and perform the azsociation

Resultz of import

20 line name Filename Status ~ '
glb1:: 2dmig Tohzgu stuffhelbl_2dmig_ Time. segy imported
#lbl::azap_paniz hzge stuffelb]_asap_pariz_Time zegy imported
zlb1::delete_me_miztie Tohzgy stuffhelb]_delete_me_mistie Time.seqy  imported
zlbZ:: 2dmig Yohzgy_stuffhalbZ_2dmig_Time. seqy imported
zlb&::azap_pariz Tihzow stuffvelb2_azap_pariz Time zegy imported
glb::delete_me_miztie Thzge stuffelbZ2_delete_me_migtie_Time.gegy  imported =
zlbd:; 2dmig Tohzgy stuffhelbd 2dmig Time. segy imported
zlhd: azap_paris vihzay_stuffszlbdazap pariz_Time seqy imported
zlbd::delete_ne_mistie Tohzgy stuffuelbd delete_me_mistie Time.zeqy  imported
2lbf:: 2dmig Thzge stuffelbB_2dmig_Time. zegy imported |
zlbf: azap_pariz Thzge stuffelbb_azap_pariz_Time.segy imported “

| £ *s \?

:

Fig. 6 Import 2D seismic and interpretation data dialog box with Seismic
tab selected

The Interpretation tab (see Fig. 7 on page 43) includes the following
parameters and results section:

Option Description

2D survey Survey to contain the 2D line interpretation to
be loaded. Select an existing survey from the
Petrel Input pane and click the blue arrow
icon. 2D seismic must be available before
interpretation can be loaded.

I nterpretation folder Folder that will contain the loaded 2D line
interpretation. Select an existing
interpretation folder from the Petrel Input
pane and click the blue arrow icon.
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Option Description

New interpretation folder If you want to import the interpretation into a
name new folder or if no folder exists enter a new
name in the adjacent text box. By default, if
you had previously loaded 2D seismic data,
the name in the New interpretation folder
name will default to “surveyname_interp”, so
that can be used, or leave it blank and a new
folder with the name “surveyname_interp”
will be created automatically. If this folder
already exists, the interpretation will be
written to it.

I nterpretation file Performs the interpretation zip file selection.
Click Browse to open the Open dialog box
to make an interpretation file selection. Only
one zip file can be selected at a time, so if
you have multiple zip files to load, say
horizons/faults and then a separate fault
boundaries file, simply run the import option
twice.

Load onto 2D lines based on This option allows you to load interpretation
these options to multiple classes/versions of 2D lines by
three methods:

« All lines - Loads the interpretation to all
the classes that exist for the 2D lines.

» First line - Loads the interpretation to the
first class of the 2D line that the importer
encounters.

» Preferred class - Only loads the
interpretation to the class specified in the
Preferred class text box.

I mport Initiates the load.

Results of import Sortable spreadsheet that reports the
horizons and faults loaded, the 2D lines the
interpretation is loaded on, and the loading
status.
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Loading 2D seismic

% Import 2D seismic and interpretation data

Seismic | Interpretation :-|-nfg

20 surves: 2D 5_'-"_‘\‘_'?5!

Interpretation folder: @ ._

MHew interpretation folder name: 2D Survey_interp

Interpretation file: "('\zg_l,J_sluff\daa_traln__45_daa zi!:ju

Load onto 200 lines bazed on these options:
) Alllines (% Firstline ) Preferred class |

Fiesultz of import

Interpretation name 20 line Status -~ .

ASAP_PARIS zlbl: delete_me_mistie imported

ASAP PARIS zlbd::delete_me_mistie imported

ASAP_PARIS zlbf: delete_me_miztie imported

B_g zlbfi:delete_me_mistie imported

B_g zlbb: delete_me_mistie imported

B_g zlb¥::delete_me_mistie imported

Cg zlb1::delete_me_miztie imported

C.g zlbfi:delete_me_mistie imported T
| ™ a b dalats e micke otk :
| € 3 |

Fig. 7 Import 2D seismic and interpretation data dialog box with

I nterpretation tab selected

The following workflow leads you through loading 2D seismic and interpretation in

the same run. You do not have to load both at the same time. You can load seismic
only, or just interpretation. But remember, that you must have seismic loaded prior
to loading interpretation.

1

» 7o Load 2D Seismic

Locate and open the GeoFrame data connector folder on the Processes
pane. Double click Import 2D seismic and interpretation data to open the
Import 2D seismic and interpretation data dialog box.

With the Seismic tab open, select an existing 2D survey from the Petrel Input
pane and click the blue arrow next to the 2D survey option or enter a new
name in the New 2D survey name text box.

Click Associate to open the Import file dialog box and make your SEG-Y file
selections. If a coordinate system has already been selected for the project, the
2D seismic will begin to load as soon as OK is selected. If no coordinate system
has been selected for the Petrel project, a prompt will appear asking you to
select a coordinate system or to select null. If null is selected, the coordinates
for the 2D seismic will be identical to those used to when exporting from
GeoFrame.

As the load starts, you are presented with the standard Petrel Input data dialog
box with information and options pertaining to the first line you are about to
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load. Review this, make any changes (none are required), and click OK to
review the next line or OK for all to have the load continue without stopping
for the rest of the lines.

5 Once the lines have loaded, review the Results of import spreadsheet within
the Import 2D seismic and interpretation data dialog box for
inconsistencies.

Importing 2D
I nterpretation

» To import 2D Interpretation

1  Select the I nterpretation tab on the Import 2D seismic and
interpretation data dialog box.

2  Select an existing 2D survey from the Input pane and click on the blue arrow
next to the 2D survey option or if you loaded 2D seismic prior to selecting this
tab the text box will be populated with the 2D survey name in which the
seismic was loaded.

3  Select an existing Interpretation folder from the Input pane and click on the
blue arrow next to the Interpretation folder option or type in a new name in the
New interpretation folder name text box. By default, if you had previously
loaded 2D seismic data, the name in the New interpretation folder name
will default to “surveyname_interp”, so that can be used, or leave it blank and a
new folder with the name “surveyname_interp” will be created automatically. If
this folder already exists, the interpretation will be written to it.

4  Select the interpretation zip file to import. Click Brow se to open the Open
dialog box. Locate and select the directory and file containing the interpretation
file. You can also manually enter the directory and file name in the text box
next to I nterpretation file.

5 Now select the option to load to multiple classes/versions of 2D lines by using
Load onto 2D lines based on these options:

+ All lines - Loads the interpretation to all the classes that exist for the 2D
lines.

+ First line - Loads the interpretation to the first class of the 2D line that the
importer encounters.

» Preferred class - Only loads the interpretation to the class specified in the
Preferred class text box.

6 Click Import.
The interpretation loads.

7 Once the interpretation has loaded, review the Results of import spreadsheet
within the Import 2D seismic and interpretation data dialog box for
inconsistencies.
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Overview

3D seismic interpretation and well data (boreholes, deviation surveys, and markers)
can be exported from Petrel using the GeoFrame data connector plug-in as zip
files. These data can be imported into GeoFrame.

Note: An OCEAN SLB GF DATA CONNECTOR license is required to launch the
GeoFrame data connector.
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Export 3D I nterpretation

3D Interpretation, horizons and faults, can be transferred from Petrel to GeoFrame
using zip files. Interpretation folders are selected from Petrel on a survey basis and
imported into GeoFrame as new interpretation models. Then Seismic I nterp
Copy & Merge (SINC) can be used to merge the interpretation into existing
interpretation models, if desired.

Export 3D Seismic I nterpretation, a GeoFrame data connector option in
Petrel, allows you to output horizons and faults to zip files that can be imported into
GeoFrame. When this option is selected, the Export 3D seismic interpretation
dialog box (see Fig. 8 on page 48) opens with the following Export
interpretation tab option and Command Bar:

Option Description

Seismic survey Select 3D survey that you want to export
horizon and fault interpretation from.

I nterpretation folder Select the interpretation folder or sub-folder
to export.
Export file Select Browse to open the Export archives

dialog box to select an output directory and
then supply a file name. The default output
directory is My Documents. A .zip will
automatically be appended to the output
filename. The selection lists in the Export
file text box.

Domain Select the domain, Time or Depth, of the
interpretation to export.

The interpretation exported is based on the Petrel survey and the interpretation
folder selected. Any interpretation folder or sub-folder may be selected and only the
interpretation that belongs to the selected survey will be exported.

There is also an I nfo tab which provides instructions on how to use this export tool.
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Fig. 8 Export 3D Seismic I nterpretation dialog box
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Export 3D I nterpretation Data Workflow

Once the plug-in is installed, you can locate it in Petrel by looking for GeoFrame
data connector in the Processes list. Once you have located this entry, open the
folder and you will see the following options:

Export 3D seismic interpretation

Import 3D interpretation and Fault Boundaries (2D and 3D)
Export well information

Import well information

Import a Framework 3D model

Import 2D seismic and interpretation data

» To Export 3D Interpretation Data From Petrel

1

Select Export 3D seismic interpretation and the Export 3D seismic
interpretation dialog box (see Fig. 8 on page 48) opens.

Select the survey that you want to export the interpretation from and click on
the blue arrow.

The Seismic Survey field is populated.

Select an interpretation folder (this can be any folder or sub-folder that
contains horizons and/or faults) and click on the blue arrow.

The I nterpretation folder field is populated.

Use the Brow se option to select the interpretation Zip file name to export.
Enter the directory and name for the output file.

Select the output Domain - Time or Depth.
Click OK.

The I nterpretation folder now exports into the specified export file name.

Note: If horizons are domain converted, the Depth or Time attribute needs to

be converted to a separate interpretation to be exported. To convert,
right click the Z attribute and select Convert to separate
interpretation before exporting interpretation data from Petrel.
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Export Well Data

Well data (boreholes, deviation surveys, markers, and log curves) can be
transferred from Petrel to GeoFrame using zip files. Borehole and well marker
folders are selected from Petrel and imported into GeoFrame into a borehole set.

Export well information, a GeoFrame data connector option in Petrel, allows you
to output boreholes, deviation surveys, and markers to zip files that can be imported
into GeoFrame. When this option is selected, the Export well information dialog
box opens (see Fig. 9 on page 52) with the Export well and I nfo tabs.

Option Description

Borehole folder Select the borehole folder that you want to
export the boreholes and deviations surveys
from.

Export markers Toggle ON to enable the export of markers to
the .zip file.

Export logs Toggle ON to export all the continuous log

curves contained in the selected boreholes.
Only continuous log curves are exported.

Note: No match and merge rules apply to log
curve transtfer. A log curve will be transferred
each time regardless of whether it already
exists in the destination GeoFrame project.

Marker folder Select the well top folder that you want to
export the markers from. This is optional and
not required if markers are not being
transferred.

Note: Two way time (TWT) values of
markers are not exported because checkshots
cannot be exported.

Preview Allows you to open the Preview Data dialog
box to review the current borehole and
marker selections. Two date filters are
available to only copy wells and markers from
a date forward (see Fig. 10 on page 53).

Borehole Date Filter To exclude boreholes created before a certain
date enter the date using the Petrel standard
syntax (MMM/DD/YYYY).

Marker Date Filter To exclude markers created before a certain
date enter the date using the Petrel standard
syntax (MMM/DD/YYYY).
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Option Description

Export file Select Brow se to open the Export archives
dialog box to select an output directory and
then supply a file name. The default output
directory is My Documents. A .zip will
automatically be appended to the output
filename. The selection lists in the Export
file text box. If no name is entered, a default
name is supplied. The name will be based on
the data types selected. The name is
“borehole folder_Logs_marker folder”.

Coordinates Displays the coordinate system information
that is currently assigned to the project. To
export the well data in a different coordinate
system, click Coordinates to open the
Coordinate reference system selection
dialog box where you can select the new
coordinate system using Petrel's standard

selector.

CRS Displays the name of the coordinate
reference system.

Use CRS/ Use WGS84 Use CRS to export the well data using the

selected coordinate system. Useful when you
have an exact match in GeoFrame. Use
WGS84 can be used to export the well data's
coordinates in WGS84 and can be useful
when coordinate systems do not match
between Petrel and GeoFrame.

There is also an I nfo tab that provides instructions on how to use this export tool.
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Fig. 9 Export well I nformation dialog box

Note: Empty boreholes with XY coordinates of (0,0) for (x,y) will not be
exported.
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Preview Data
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Fig. 10 Preview Data dialog box
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Export Well Data Workflow

Once the plug-in is installed, you can locate it in Petrel by looking for GeoFrame
data connector in the Processes list. Once you have located this entry, open the
folder and you will see the following options:

Export 3D seismic interpretation

Import 3D interpretation and Fault Boundaries (2D and 3D)
Export well information

Import well information

Import a Framework 3D model

Import 2D seismic and interpretation data

» To Export Well Data From Petrel

1

10

Select Export well information and the Export well I nformation dialog
box opens.

Select the borehole folder that you want to export the well data from and click
on the blue arrow next to Borehole folder.

The Borehole folder field is populated.

In Options, toggle ON Export markers to export markers and enable the
Marker Folder option. Toggle ON Export logs to export all the continuous
logs for the selected boreholes.

Select the well top folder that you want to export the markers from and click
the blue arrow next to the Well top folder.

The Well top folder field is populated and the Export file field’s default
export file name is appended with a the marker folder’s name.

(Optional) Click Preview to open the Preview Data dialog box to review the
boreholes and markers that will be sent to GeoFrame.

(Optional) At the bottom of this Preview Data dialog box, there is a date
filter that can be used to limit the boreholes and markers sent to GeoFrame.
Any boreholes and markers that were created on or after the date entered will
be sent. Enter the dates (syntax example is Jan/25/2011) in the Borehole
Date Filter and Marker Date Filter text boxes. Click Enter after typing in
the dates and the Preview Data dialog box will be filtered with the updated
borehole list.

Use the Browse option to select the well data Zip file name to export.
Select the directory and enter the name for the output file.

Select a coordinate system to export the well data in by clicking Coordinates
to open the standard Petrel Coordinate reference system selection dialog box
and make a selection and click OK or export using WGS84 which is ON by
default.

If a coordinate system is selected, information will populate the Coordinates
and CRS text boxes.

Click OK.

The well data now exports into the specified export file name.
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Overview

3D seismic interpretation and well data (boreholes, deviation surveys, and markers)
exported from Petrel as zip files can be imported in GeoFrame. These exported
data can be imported into GeoFrame using Basemap > Petrel > Import from
Petrel.

Note: A gf data manager license is required to run this option.
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Petrel > Import from Petrel

Basemap is used to import 3D data exported from Petrel into GeoFrame using
Petrel > Import from Petrel > I mport I nterpretation. When this option is
selected, the Import Seismic I nterpretation from Petrel dialog box opens with
the following options (see Fig. 11 on page 58) and Command Bar:

Option Description

Select 3D Survey Select the 3D survey to load the
interpretation into. The selected survey name
does not have to be the same as the survey
used to export in Petrel. The Inline/ CDP
ranges that match between the input file and

the output file will be imported. Click the [
icon to launch the General Attribute Editor
for the survey and then click To Entity
Geometry to open the Grid Library Editor
to view the survey information on the
selected survey.

I nterpretation File Use Select File to open the Select

I nterpretation File dialog box, which is the
standard GeoFrame file selector, and select
a zip file exported from Petrel. The selection
lists in the I nterpretation File text box.

Note: An environment variable,

GF _PETREL OUT _DIR, can be set as a
default directory for the import from Petre/
and the export to Petrel so that when the
import or export dialog box is opened, it will
automatically be populated with that
directory. To set the variable, in a GeoFrame
xterm, type: setenv GF_PETREL OUT DIR
"desired output directory”.

Note: Import from Petrel only recognizes
Zip files exported from Petrel, and does not
support Zip files exported from GeoFrame or
other applications.

Interpretation Model Name Enter a new interpretation model name. This
must be a new name and cannot be a name
of an existing interpretation model in the
domain of the incoming interpretation.

Launch “Seismic I nterp Copy & | This option allows you to start SINC after the
Merge” after Import import is complete to merge interpretation
from the new interpretation model into an
existing model. This functions for both
Charisma and | ESX interpretation. Please
refer to the online documentation for
information regarding SINC and usage
differences for Charisma and | ESX.
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Note: When GeoFrame exports horizon patches to Petrel, there are double
colons inserted between the horizon name and the patch name (example,
horizon_red::patch_A). When this horizon patch is imported from Petre/
into GeoFrame, the double colons identify it as a horizon with a patch
name and it will be imported into GeoFrame without the colons and is
used as the separator of the horizon name and the patch name. For the
example above, this will be split into horizon_red with a patch of patch_A.

Note: Agf data manager license /s required to launch and run Import
from Petrel.

- Import Seismic Interpratation from Petrel =07
Select 3D Survey(6 displayed) ﬂ]
3

T oo Remarks l
Jd_choudspin_char - Survey 3D Area tminh

cloudspin survey - Survey 3D Area iraindev 3D cloudspin prospect s
woestcam - Survey 3D Area yumis  West Cameron - weslica
westcam_ch - Surve
wic eld3 - Survey 3D Area rhiamis eugeng island adfacent |
wijc eid3 ch - Survey 3D Area iminh

o

I I -

Selection | westcam ch - Survey 3D_frea

Interpreiation File ImmefcmMSersfseismicMaafgeuf- Select File

Interpretation kModel Hame i{Pe.treI_Deiwrt_cluudspin_amey_

B |aunch "Seismic Interp Copy & Merge" after Import
ok | Apply cncel | Help |
Bl

Fig. 11 Import Seismic I nterpretation from Petrel dialog box
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I mport I nterpretation Workflow

» To/mport 3D Interpretation Data From Petrel into GeoFrame

1

Open the GeoFrame project you want to import the interpretation into, start
Basemap, and choose a map to open.

From the menu bar select Petrel > I mport from Petrel > I mport
I nterpretation and the  mport Seismic | nterpretation from Petrel
dialog box opens (see Fig. 11).

Select the survey from the Select 3D Survey section that you want to import
the interpretation from Petrel into. Survey names do not have to be the same.

Click Select File to open the Select I nterpretation File dialog box to select
the interpretation zip file you exported from Petrel.

Make the selection and click OK.
Type a new model name in the I nterpretation Model Name text box.
This is the model that the interpretation will be written to.

(Optional) Toggle the “Launch Seismic I nterp Copy & Merge” after
Import button ON if you want to start SINC after the import is complete to
merge interpretation from the new interpretation model into an existing model.
For information regarding SINC usage, see Seismic | nterpretation Copy &
Merge online help.

Click OK to start the import.
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Import Well Data

Well data (boreholes, deviation surveys, markers, and log curves) can be transferred
from Petrel to GeoFrame using zip files. Petrel borehole and well marker folders
exported as Zip files can be imported into GeoFrame using Basemap > Petrel >
Import from Petrel > Import Wells.

Import Wells, allows you to import the boreholes, deviation surveys, markers, and
log curves that were exported from Petrel as Zip files. The following rules apply
when the boreholes and markers are loaded:

» Boreholes, surfaces, markers, and log curves will be imported according to the
default GeoFrame Match-Merge rules.

« All new data items imported from Petrel are assigned Petrel as their Source and
their Remarks field will contain the Petrel project name and the user name of the
Petrel exporter.

» For boreholes that find a match in GeoFrame, no new fields will be created, but
there is a field name in the zip file and for boreholes that do not find a match, that
field name will be used in GeoFrame. If there is an existing field with that name,
it will be used. If not, a new field with that name will be created.

* The KB of a well will not be updated unless a well is new or does not have a
preferred deviation survey.

» |f a borehole is loaded with a missing Unique Well Identifier (UWI), the UWI will
be set to the borehole name.

» The deviation survey automatically becomes the preferred deviation survey for
boreholes that do not exist in GeoFrame.

» When loading a deviation survey to a matched borehole in GeoFrame and there
is not a preferred survey set, it will be set as preferred.

» When loading a deviation survey to a matched borehole in GeoFrame with a
preferred deviation survey set, the deviation survey is loaded but not set to
preferred. You must perform this task manually.

» Deviation surveys are transferred as Inclinometry Data - MD, TVD, DX, and DY
arrays - and default to grid north referenced.

» Checkshots are currently not transferred.
« Markers are transferred with their MD values. No time values are transferred.

» Markers are assigned Petrel as the Source and the Remarks field is populated
with Exported from the Petrel project "project_name" by user "user_name".
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When this option is selected, the Import Wells from Petrel Project dialog box
(see Fig. 12) opens with the options and a Command Bar:

Option Description

I mport Archive Opens the Select Petrel Well Archive File
dialog box that allows you to select the Zip
file created in Petrel to load into GeoFrame
using the GeoFrame standard file selector.

Borehole Set Allows you to select the borehole set to
transfer the boreholes into. Click Borehole
Set to open the Select Borehole Set dialog
box that contains the options:

» Query from - Displays the project name in
a read only text box.

» Collection - Select the borehole set from
a list of all the borehole sets in the project.

The ﬂl icon can be used to open the
Collection Editor for the selected
borehole set. This can be used to view the
boreholes that are currently in the borehole
set. Find can be used to locate a borehole
set if you have a large number of borehole
sets in the list.

If no borehole set selection is made the
boreholes will be loaded to the Wells From
Petrel borehole set which will be
automatically created when OK or Apply is
clicked.

Note: Only list based borehole sets are
listed and available for selection.

» Project Match Rule - Displays the name
of the current Match Rule in place for the
project.

* Merge Rules - Displays the merge rules
that are in effect for importing boreholes.
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= Import Wells from Petrel Project

Borehole Set ... | [wWells From Petrel

Project Match Rule: Default.

Merye Rules: Updatefinsert for boreholes, markers and surfaces. Skip/insert for Deviation Surveys.

Fig. 12 Import Wells from Petrel Project dialog box
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Import Wells Workflow

» To/mport Well Data From Petrel into GeoFrame

1 Open the GeoFrame project you want to import the well data into, start
Basemap, and choose a map to open.

2 From the menu bar, select Petrel > Import from Petrel > I mport Wells
and the Import Wells from Petrel Project dialog box opens.

3 Click Import Archive to open the Select Petrel Well Archive File dialog
box to select the well data zip file you exported from Petrel.

4  Make the selection and click OK.
The Import Archives text box populates with the input file name.

5 Click Borehole Set to open the Select Borehole Set dialog box and select
the borehole set to load to or use the “Wells From Petrel” default borehole set
name.

The Borehole Set text box populates with the borehole set selected.
(Optional) Review the Project Match Rule and Merge Rules.
7 Click OK.

The well data is loaded into GeoFrame.
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7 Installation
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Plug-in Access and | nstallation

The GeoFrame data connector plug-in is loaded through the Ocean Plug-in
Manager. The file extension on the plug-in file is a .pip file. Instructions for
installing the file are listed below for a fresh install to Petrel 2013.1 and a re-install in
Petrel 2012.x, where x could be 2012.1 through 2012.6.

The GeoFrame data connector plug-in for Petrel 2013.1 and Petrel 2012.x can be
accessed from the Ocean Store and is also included in GeoFrame 2012_SP 3. The
plug-in is 64-bit only and is license controlled. The license is

OCEAN SLB_GF_DATA CONNECTOR and can be obtained when ordering the plug-in
from the Ocean Store. If you run Bedrock, you no longer need a

gf geoframe_ server license.

If you are planning on running the GeoFrame/ Studio/ Petrel workflow for Petrel
2013.1, you must have Studio Manager installed and then install
GeoFrame2012SP3ProjectIndexerforStudio2013.msi. For Petrel 2012.x,
you must load the GeoFrame2012SP3ProjectIndexerforDEM2012.msi file.
Instructions for loading these files and workflow information can be found in the
GeoFrame/ Studio/ Petrel I ntegration document.

» To /nstall The GeoFrame Data Connector Plug-in For Petrel 2013.1
Install GeoFrame 2012_SP_3.
Open a GeoFrame xterm.

1
2
3 Typein the following at the prompt: cd $spl/workstation
4

Locate the GeoFrame2012SP3DataConnectorForPetrel2013.1.pip file
using the 1s command or some other appropriate command.

5  Copy this file to the PC where Petrel 2013.1 is installed.

Note: If the PC has access to UNIX/Linux directories through, for example, a
SAMBA server, then this can be used rather than performing the copy.

6  Open Petrel 2013.1 and select Help > Ocean Plug-in Manager.
The Ocean Plug-in Manager dialog box opens.

7  Click Install plug-in to open the Install Plug-in dialog box. Locate the
GeoFrame2012SP3DataConnectorForPetrel2013.1.pip file and click
Open.

The Ocean Plug-in Manager opens, and the plug-in installs with information
listed about the installation.

8 Verify the GeoFrame Data Connector lists with a green check next to it in
the Ocean Plug-in Manager dialog box. Exit Petrel.

9  Restart Petrel and verify that the GeoFrame data connector is listed and
checked in the Ocean plug-ins folder in the Select license package dialog
box. Check the box next to the GeoFrame data connector. If the box cannot
be checked or is dimmed, this may indicate you do not have the proper license
for the plug-in. The license is OCEAN_SLB_GF_DATA_ CONNECTOR and can be
obtained from the Ocean Store.
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10 Click OK in the Select license package dialog box to open Petrel.

11 Locate the Bedrock server and GeoFrame data connector folders in the
Processes pane.

12 Select the option you want to start transferring data from/to GeoFrame.

Note: Once the plug-in has been installed using the .pip file using the Ocean
Plug-in Manager in Petrel, the Ocean Plug-in Manager should be used for
any future un-installation or installations.

» To /nstall The GeoFrame Data Connector Plug-in For Petrel 2012.x
With An Existing GeoFrame Data Connector Plug-in I nstalled

Install GeoFrame 2012_SP_3.

Open a GeoFrame xterm.

Type in the following at the prompt: ¢cd $spl/workstation

H W N =

Locate the GeoFrame2012SP3DataConnectorForPetrel2012.2.pip file
using the Is command or some other appropriate command.

5  Copy this file to the PC where Petrel 2012.x is installed.

Note: If the PC has access to UNIX/Linux directories, through for example a
SAMBA server, then this can be used rather than performing the copy.

6  When you have previously installed the GeoFrame data connector plug-in for
Petrel 2012.x, you must uninstall it prior to installing the new plug-in.

7  To uninstall the plug-in, open 2012.x and select Help > Ocean Plug-in
Manager.

The Ocean Plug-in Manager dialog box opens.

8 Locate GeoFrame Data Connector in the list of installed plug-ins and click
MB1 on it. Information displays about the plug-in and Disable and Uninstall
options appear.

Locate and click MB1 on Uninstall. The plug-in uninstalls. Exit Petrel.
9 Open Petrel 2012.x and select Help > Ocean Plug-in Manager.
The Ocean Plug-in Manager dialog box opens.
10 Click I nstall plug-in to open the I nstall Plug-in dialog box.

11 Locate the GeoFrame2012SP3DataConnectorForPetrel2012.2.pip file
and click Open.

The Ocean Plug-in Manager opens, and the plug-in installs with information
listed about the installation.

12 Verify the GeoFrame Data Connector lists with a green check next to it in
the Ocean Plug-in Manager dialog box. Exit Petrel.
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13

14
15

Restart Petrel and verify that the GeoFrame data connector is listed and
checked in the Ocean plug-ins folder in the Select license package dialog
box. Check the box next to the GeoFrame data connector. |f the box cannot
be checked or is dimmed, this may indicate you do not have the proper license
for the plug-in. The license is OCEAN SLB GF DATA CONNECTOR and can be
obtained from the Ocean Store.

Click OK in the Select license package dialog box and Petrel opens.

Locate the Bedrock server and GeoFrame data connector folders in the
Processes pane. Select the option you want to start transferring data from/to
GeoFrame.
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GeoFrame to Petrel

Supported Functions

Well Data boreholes
checkshots
deviation surveys
markers
lithofacies
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY
2D seismic interpretation

Framework 3D models

GeoFrame Version
GeoFrame 2012_SP_3

Petrel Version

Petrel 2013.1

Petrel 2012.1 through
2012.6

Well Data boreholes
checkshots
deviation surveys
markers
lithofacies
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY
2D seismic interpretation

Framework 3D models

GeoFrame 2012_SP 2

Petrel 2012.1
through Petrel 2012.5

Well Data boreholes
checkshots
deviation surveys
markers
lithofacies
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY
2D seismic interpretation

Framework 3D models

GeoFrame 2012 _SP 1

Petrel 2012.2
Petrel 2012.1

GeoFrame to Petrel
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Supported Functions

Well Data boreholes
checkshots
deviation surveys
markers
lithofacies
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY
2D seismic interpretation

Framework 3D models

GeoFrame Version
GeoFrame 2012

Petrel Version
Petrel 2012.1
Petrel 2011.2

Well Data boreholes
checkshots
deviation surveys
markers
lithofacies
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY
2D seismic interpretation

Framework 3D models

GeoFrame 4.5 TK 2

Petrel 2011.1
Petrel 2010.2

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY
2D seismic interpretation

Framework 3D models

GeoFrame 4.5 TK 1

Petrel 2010.2
Petrel 2010.1

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame 4.5 SP 5

Petrel 2010.2
Petrel 2010.1
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Supported Functions

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame Version
GeoFrame 4.5 SP 4

Petrel Version

Petrel 2010.2

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame 4.5 SP 3

Petrel 2010.1

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame 4.5 SP 2

Petrel 2009.2

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame 4.4 GP 5

Petrel 2009.2
Petrel 2009.1

GeoFrame to Petrel
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Supported Functions

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame Version
GeoFrame 4.5 _SP 1

Petrel Version

Petrel 2009.2
Petrel 2009.1

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame 4.4 GP 4

Petrel 2009.2
Petrel 2009.1

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame 4.5

Petrel 2009.1
Petrel 2008.1

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D ZGY export
3D seismic interpretation
2D SEGY

Framework 3D models

GeoFrame 4.4 TK 2

Petrel 2009.1
Petrel 2008.1
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Supported Functions

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D seismic interpretation

Framework 3D models

GeoFrame Version

GeoFrame 4.4 GP_3

Petrel Version

Petrel 2009.1
Petrel 2008.1

Well Data boreholes
checkshots
deviation surveys
markers
log curves

Seismic
3D seismic interpretation

Framework 3D models

GeoFrame 4.4 GP_2

Petrel 2009.1
Petrel 2008.1

Seismic
3D seismic interpretation

Framework 3D models

GeoFrame 4.4 _GP_1

Petrel 2008.1
Petrel 2007.1
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Petrel to GeoFrame

Supported Functions GeoFrame Version Petrel Version
Well Data GeoFrame 2012_SP_3| Petrel 2013.1
bort_ahc_)les Petrel 2012.1 through
deviation surveys
2012.6
markers
log curves

3D seismic interpretation

Well Data GeoFrame 2012_SP_2| Petrel 2012.1

bort_ahqles through Petrel 2012.5
deviation surveys

markers
log curves

3D seismic interpretation

Well Data GeoFrame 2012_SP_1| Petrel 2012.2
boreholes Petrel 2012.1

deviation surveys
markers
log curves

3D seismic interpretation

Well Data GeoFrame 2012 Petrel 2012.1
boreholes Petrel 2011.2

deviation surveys
markers

3D seismic interpretation

Well Data GeoFrame 4.5_TK_2 | Petrel 2011.1

bort_ehqles Petrel 2010.2
deviation surveys

markers

3D seismic interpretation

3D seismic interpretation GeoFrame 4.5 TK 1 | Petrel 2010.2

Petrel 2010.1
3D seismic interpretation GeoFrame 4.5 SP 5 | Petrel 2010.2

Petrel 2010.1
3D seismic interpretation GeoFrame 4.5 SP 4 | Petrel 2010.2
3D seismic interpretation GeoFrame 4.5 SP 3 | Petrel 2010.1
3D seismic interpretation GeoFrame 4.5_SP_2 | Petrel 2009.2
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Supported Functions GeoFrame Version Petrel Version

3D seismic interpretation GeoFrame 4.5_SP 1 | Petrel 2009.2
Petrel 2009.1

3D seismic interpretation GeoFrame 4.5 Petrel 2009.1
Petrel 2008.1
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| ndex

A
about Schlumberger 6

C

contacting Schlumberger 9

D

dialog boxes
Export 3D seismic interpretation 47
Export Data for Petrel Project 16
Export Data to Petrel
options
GeoFrame Data Type 16
Output Selections 16
Petrel Output Controls 16
Export Framework to Petrel 32
Import 3D interpretation Fault Boundaries (2D and 3D) 36
Import a Framework 3D model 38
Import Seismic Interpretation from Petrel 57
Import Well Information 38
Import well information 37
Input data 35
Save Polygon Selector 18
Select Interpretation File 57

E

environment variable
GF_PETREL_OUT_DIR 57

G

gf_data_manager license 58

Import from GeoFrame
Process list
options
Export 3D seismic interpretation 36
Import 2D seismic and interpretation 36
Interpretation folders 47

L

licenses
Index 77
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gf_data_manager 11

OCEAN_SLB_GF_DATA_CONNECTOR 11
log file

bmap_petrel_batch.inf 30

bmap_petrel_run.log 30

MB3 menu options
Break 17
Clear 17
Draw 17
Save 17

o)

Output Directories
Fault boundaries 29
GF_PETREL_OUT_DIR 29
Interpretation 29
Seismic 29
Well data 29

overview
Export 3D Seismic Interpretation 47
Export Framework to Petrel 31
GeoFrame Data Connector 11
loading 2D seismic export/import 21

P

Polygon Selection
modes
Graphic 16
List 16

tab
Export interpretation 47
Info 47
Interpretation 16
Seismic 16
Well Data 16

Technical Support 9

w

workflow
export 2D and 3D stacked seismic, interpretation models, and well data to SEGY,
ZGY, and Zip files 14
export 3D interpretation data from Petrel 49
export a structural framework 31
export well data from Petrel 54
graphically make a selection polygon 17
import 2D interpretation 44
import 3D interpretation data from Petrel into GeoFrame 59
import an interpretation model 36
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import well data from Petrel into GeoFrame 63

import well information 37

install the GeoFrame data connector plug-in for Petrel 2012.x with an existing
GeoFrame data connector plug-in installed 66

install the GeoFrame data connector plug-in for Petrel 2013.1 65

load 2D seismic 43

read the ZGY data into Petrel 35

use saved rectangles and polygons in the selection area 18
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